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Introduction
This guide describes how to customize and use ICVERIFY for Windows. It is intended for 
merchants who want to use ICVERIFY to process transactions.

� For information on setting up ICVERIFY, see the ICVERIFY for Windows 
User Guide.

Style Conventions
This section describes the styles that are used in this document.

Bold type indicates items such as file names, window names, and buttons.

Italics type indicates a reference to another document, or terms that are defined within the text.

Information that you will see as output on a screen, information that you must input, and 
system prompts are indented and in a smaller typeface than the document’s body text.

xcopy autoexec.bat autoexec.bak

� Indicates suggestions or additional, detailed, information.

� Indicates actions you must take or avoid for the system to operate 
properly.
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Prerequisites
Prior to installing ICVERIFY, you must complete the following tasks:

• Establish a merchant account.

• Check that your computer system meets the minimum requirements.

• Obtain your processor setup information.

• Install ICVERIFY.

• Set up ICVERIFY.

• Register ICVERIFY.

� Before you start, you must have established a merchant account with a 
financial institution. ICVERIFY only functions with a merchant account. 
You also need to check that your computer system meets the minimum 
system requirements. For more information, see System Requirements.

System Requirements
To use ICVERIFY, you need the following:

• 486 DX2 66 computer (Windows 95/98) or Pentium 166 (Windows NT)

• 20 megabytes of free hard drive space

• 32 megabytes of RAM

• 1.44 megabyte floppy disk drive

• Encrypted PINpad (PINpads must be programmed by your bank before they can be 
used with ICVERIFY) if you plan to accept debit/ATM cards

• 100% Hayes compatible modem (Bell 103 for 300 baud, Bell 212a for 1200 baud, 
CCITT V22bis for 2400 baud)

� High-speed modems must be able to step down to 300 baud if you are 
using check guarantee or 1200 for credit card processing.
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� ICVERIFY can be configured to accept input from a magnetic card stripe 
reader. In many cases, this allows you to obtain a lower discount rate for 
processing credit cards. For “card not present” transactions (such as 
mail order) card information can be entered via the keyboard. For 
instructions on configuring your card stripe reader, see your 
manufacturer’s documentation.

Getting Help
The following is a list of the available Help features ICVERIFY has to assist you:

• http://www.cybercash.com/icverify/support/—provides a forum for getting your 
questions answered and accessing archived help information.

• context-sensitive Help—allows you to point to an area of the interface that you would 
like more information about. To use this Help, click the question mark in the interface 
and then click the area of the interface in question.

• GUI Help—allows you to access a directory and index of helpful information. To use 
this Help, press F1 while you are using ICVERIFY.

• setup Help—allows you to access a directory and index of helpful setup information. 
To use this Help, press F1 while you are using Advanced Setup.

� You can also call 1-800-900-6133 for Customer Service assistance, or 
send email to the following email address:
support@icverify.com
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 CHAPTER 1 Processing 
Transactions
This chapter covers processing modes and the functions available for processing the 
following types of transactions:

• credit card

• debit card

• check guarantee

Processing Modes
There are two processing modes that can be used to process transactions: Real Time Mode 
and Offline Group Mode.

Understanding the Real Time Processing Mode
ICVERIFY defaults to processing transactions as soon as they are entered. This is referred to 
as Real Time Mode. With Real Time Mode, each time you enter a transaction and click 
Submit, ICVERIFY immediately uses the computer’s modem to submit the transaction to 
your processing network.
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Understanding the Offline Processing Mode
Offline Group Mode stores transactions in a batch file for processing at a later time. Offline 
Group Mode is more convenient for some merchants because it cuts down on transaction 
processing time. The modem connects to the processing network once, and submits the stored 
transactions as a group without re-dialing for each one. Also, an offline group can be 
transmitted to the processor at a time that is convenient to you.

To enable the Offline Group Mode, choose Off-Line Group Mode from the Function menu. 
The screen color of your ICVERIFY interface will change to blue to indicate that you are in 
Offline Group Mode.

Settlement
If you are signed up with a terminal-based processor, you will need to perform a settlement/end 
of day process before the funds from approved transactions are deposited in your account. This 
is done by choosing Settlement/End Day from the Function menu.

Understanding the Importance of Password Protection
It is extremely important when using ICVERIFY to exercise caution when storing and handling 
sensitive payment information. It is also important that you password protect certain areas of 
ICVERIFY that contain payment information (for example, the credit function, the export 
function, the customer database, and reporting), and store your passwords in a secure place to 
prevent tampering.

To access the password feature:

1. From the Utilities menu, choose Passwords.... 
The Passwords dialog is displayed.

2. In the Password For field, select the transaction process you want to password protect.
The Select Transaction/Select Menu field is automatically populated with the field 
names used for that transaction process.

� This field name will change, depending on whether you are referring to 
a form password (in which case it will read Select Transaction) or a 
menu password (in which case it will read Select Menu).
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3. Click the item you want to password protect, and then click one of the following:

• Select Password—to create a password.

• Change Password—to change an existing password.

• Remove Password—to remove password protection.

A dialog is displayed allowing you to manipulate your password.

� All passwords, with the exception of Password Entire Program, take 
effect immediately. You must restart ICVERIFY to be prompted for your 
program password.

Processing Credit Card Transactions
This section describes the processing functions available for handling credit card transactions.

� When started, ICVERIFY displays the terminology used by your 
processing network. For example, the tab for a credit transaction might 
be labeled as a refund or return depending on the processing network 
you are using. For each transaction type explained in the following 
pages, an attempt is made to present all of the possible terms used so 
that you can recognize the transaction process being discussed. 

� Do not use dashes or spaces when manually entering account numbers 
for credit card transactions (for example, use 411111111111, not 
4111-1111-1111).

Finding Credit Card Transactions 
The Find Current Credit Card Transaction feature allows you to quickly search for a 
specific transaction. This feature is automatically started when you click the Void, Credit 
Void, Force, and Ship transaction tabs. For example, when you click the Void tab, the Find 
Current Credit Card Transaction page opens and allows you to search for all transactions 
that can be voided. 
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� The Find Current Credit Card Transaction feature is dependent on 
the operational mode of the software. If you are operating in Real Time 
Mode, the current open batch is searched. If you are operating in Offline 
Group Mode, Offline Group transactions are searched. If you are 
operating in Training Mode transactions processed while in Training 
Mode are searched. 

You can also use the Find Current Credit Card Transaction feature for Sale, Book, Ship, 
Refund, and Auth Only transactions by following the procedure below.

To find a transaction:

1. From the Edit menu, choose Find Current Transaction. 
The Find Current Credit Card Transaction dialog is displayed. 

2. Specify the search criteria for the transactions you are searching for.

3. Click Start Search. 
A list of transactions is displayed using the search criteria you specified.

� To display one transaction at a time, click One by One in the Show 
Results area. To view the next transaction, simply click Next 
Transaction.

4. In the Search Results field, click the transaction you are searching for. At this point you 
have the following options:

• ALT+R—allows you to reprint the receipt

• ALT+W—allows you to view the transaction

• Convert To... (ALT+T)—allows you to convert the transaction to another transaction 
type

• Clear Criteria (ALT+C)—allows you to clear the criteria you specified.

• New Search (ALT+N)—allows you to begin a new search

� The Find Current Credit Card Transaction feature searches for 
unsettled transactions only. To locate a settled transaction, choose Find 
Settled Transaction from the Utilities menu. For more information on 
the Utilities menu, see Utilities Menu, page 68.
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Credit Card Transaction Types in the Retail Environment 
This section explains the various transaction types you can perform while processing credit 
cards in the retail format. In addition to the transactions types presented in this section, Book 
and Ship transactions are also available in many retail environments. For information on Book 
and Ship transactions, see Credit Card Transaction Types in the Mail Order Format, page 13.

Sale. A sale is the most common transaction in a retail format. It is used to charge a customer’s 
credit account for a purchase. It places a hold on the customer’s available credit for the amount 
of the sale. Once a sale has been approved, the hold on the customer’s credit will be valid for a 
limited time (three to 30 days depending on the cardholder’s bank) before expiring and 
releasing the hold. Funds from an approved sale transaction will not be deposited into your 
account until they have been settled. This will occur automatically if you are using a host-
based processor that auto-settles transactions. 

If you are using a terminal-based processor (or a host-based processor that does not auto-
settle), you must perform a settlement/end day procedure for the funds from sales to be 
transferred to your account. 

To enter a sale:

1. In the ICVERIFY window, click the Sale tab. 

2. In the Customer Information area, enter the credit card information.

OR

Swipe the credit card being used for the transaction to automatically populate the fields 
in the Customer Information area with the customer’s credit card information

3. In the Clerk and Comment fields, type any necessary information (these fields are 
optional). 

� The clerk’s name can be typed directly into the Clerk field, or selected 
from the menu. (Clerks can be added to this menu by choosing Options 
from the Edit menu, and clicking the Clerks tab.) The Comment field 
can be used to enter a comment or invoice number that can be used to 
reference the transaction at a later point. Depending on your processor 
you are using, the Comment field may be named differently.

4. Click Submit to process the transaction. 
The status of the transaction processing procedure is displayed in the Response field.
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Void. This transaction is used to remove a sale transaction from an open batch before it has 
been settled. Performing a void cancels the sale before it is processed, so no funds are 
transferred. A sale can be voided only if it has not been settled. If a sale has been settled, a 
credit transaction must be performed. For more information on credit transactions, see 
Credit/Refund/Return, page 10.

To perform a void transaction:

1. In the ICVERIFY window, click the Void tab. 
The Find Current Credit Card Transaction dialog is displayed. 

2. Click Start Search to view a list of the transactions in the open batch that can be voided.
Eligible transactions are displayed in the Search Results field.

3. Highlight the transaction that you want to void, and click Convert To....

4. Click Credit Void. (The terminology will very, depending on your processing network.)
You are returned to the Void tab of the ICVERIFY interface. The transaction information 
is filled in the appropriate fields.

5. Click Submit. 
The status of the void processing procedure is displayed in the Response field.

� For terminal-based processors, ICVERIFY does not dial out for approval 
when a void transaction is submitted (for most host-based processors, 
the software dials out to the processing network when the void 
transaction is submitted). 

�A transaction that has been voided may continue to hold funds from a 
customer’s available credit until it has expired or is settled.

Credit/Refund/Return. A credit transfers money from the your account to the customer’s 
account. It is used to return funds to the customer’s account after a transaction has been settled. 

� For terminal-based processors, ICVERIFY does not dial out when a credit 
is submitted. Instead, the credit is stored in the open batch and 
transmitted at settlement. For most host-based processing networks, 
ICVERIFY dials when a credit is submitted. 
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To perform a credit transaction: 

1. In the ICVERIFY window, click the Credit tab. (The terminology will vary by processing 
network.)

2. In the Customer Information area, type the information for the transaction that you 
want to credit.

3. Click Submit.
The status of the credit processing procedure is displayed in the Response field.

Credit Void/Cancel Return/Refund Void. A credit void is used to clear an unsettled credit 
transaction from your records. It is used after you perform a credit to a customer account 
erroneously, to cancel the credit.

� A credit void cannot be performed if the credit has already been settled.

To void a credit transaction:

1. In the ICVERIFY window, click the Credit Void tab. (The terminology will vary by 
processing network.)
The Find Current Credit Card Transaction dialog is displayed.

2. Click Start Search.
A list of all the credit transactions that can be voided in the open batch is displayed.

3. Click the credit transaction that you want to void and click Convert To.... 

4. Click Void. 
The Credit Void tab in ICVERIFY is populated with information for that transaction. 

5. Click Submit. 
The status of the credit void processing procedure is displayed in the Response field.

� If a terminal-based processor is being used, ICVERIFY does not dial out 
to the processing network when the credit void is submitted. For most 
host-based networks, the software dials out when a credit void is 
submitted.
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Auth Only/Pre-Authorization. An auth only transaction is used to verify that funds are 
available for an account and to return an approval code. This transaction cannot be settled 
unless it has been completed using a force transaction. 

� Auth Only transactions are cleared out of the batch each time a 
settlement is performed. 

To perform auth only transaction:

1. In the ICVERIFY window, click the Auth Only tab. (The terminology will vary by 
processing network.)

2. In the Customer Information area, type the information for the transaction you want to 
authorize.

3. Click Submit.
The status of the auth only processing procedure is displayed in the Response field.

Force/Post-Authorization. A force is used to complete an auth only transaction. A force is 
also used to submit a transaction using an approval code provided by your processor’s Help 
desk.

To perform a force transaction:

1. In the ICVERIFY window, click the Force tab. (The terminology will vary by processing 
network.)
The Find Transaction dialog is displayed.

2. Click Start Search to view a list of all auth only transactions in the open batch that can 
be forced.
The transactions are displayed in the Search Results field.

3. Click the transaction that you want to force and click Convert To....

4. Click Force. 
The Force tab in ICVERIFY is populated with information for that transaction.

5. Click Submit. 
The status of the force processing procedure is displayed in the Response field.

� If you are using a terminal-based processing network, ICVERIFY does not 
dial out when a force transaction is submitted (it will be transmitted at 
settlement). For most host-based processing networks, the software 
dials out to the processing network when a force transaction is 
submitted.
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� You can also use a force transaction to enter a voice approval into the 
open batch. For example, if you submit a card for approval and get a 
voice authorization message, you can call the merchant Help desk for a 
voice authorization for that credit card number. The merchant Help desk 
gives you an approval code for the transaction over the phone. You can 
enter the transaction into the open batch using a force transaction; 
entering the approval code obtained over the phone.

� If you are on a terminal-based processing network, you MUST complete 
the pre-authorized transaction with a Force, or you will not get paid for 
the transaction.

Credit Card Transaction Types in the Mail Order Format 
The Mail Order format includes all of the processing functions available when using the retail 
format, plus two additional transaction types (book and ship), which are often used in place of 
a sale transaction. For more information on the different processing functions available, see 
Credit Card Transaction Types in the Retail Environment, page 9.

Since mail/telephone order transactions are generally not able to be swiped by a card reader 
(the cardholder is not present), address verification information (the customer’s address and 
ZIP code) is usually required to get the best rate from the processing network. For percentage 
rate details, contact your financial institution.

� Make sure the Billing Address and Zip fields are present in the 
Customer Information section of your ICVERIFY interface. If these 
fields are not present, click the Merchant Information tab in 
Advanced Setup and set Address Verify?(Y/N) to Y. 

� There may be processor-specific setup items that affect the ability to 
pass address verification information. These setup items are assigned by 
the processing network. Contact your processing network for 
information on what setup items affect address verification to know if 
you are effected.
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Book. A book transaction authorizes and places a hold on the transaction amount (the hold on 
the customer’s credit will be valid for a limited time, usually three to 30 days depending on the 
cardholder’s bank). It is done at the time of the order. A book transaction is the first of a two-
part transaction, and it cannot be settled until a ship transaction is performed. For more 
information on a ship transaction, see Ship.

To perform a book transaction:

1. In the ICVERIFY window, click the Book tab.

2. In the Customer Information area, type the information for the transaction you want to 
book.

3. Click Submit.
The status of the book processing procedure is displayed in the Response field.

� You can set ICVERIFY to delete any unfulfilled (unshipped) book 
transactions after a specified length of time by typing a value in the # 
Days to Keep Books/Tips field of the Options tab in Advanced Setup. 
These transactions will be purged.

Ship. This transaction is used to complete a book transaction. It is done at the time of 
shipment. Once a ship transaction has been performed, the transaction is eligible for 
settlement. 

To ship a transaction:

1. In the ICVERIFY window, click the Ship tab. 
The Find Current Credit Card Transaction dialog is displayed.

2. Click Start Search to view a list of approved book transactions.

3. Click the book transaction for which you want to perform a ship, and click Convert 
To....

� The amount of the ship can be different from the amount of the book, 
depending on limits set by your processor. Contact your merchant Help 
desk for information.

4. Click Ship. 
This returns you to the Ship tab of the ICVERIFY interface. The transaction information is 
filled in the appropriated fields.
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5. Click Submit. 
The status of the ship processing procedure is displayed in the Response field.

� For terminal-based processors, ICVERIFY does not dial if a ship 
transaction is submitted for the same amount as the book (it will be 
transmitted to the processing network at settlement). If the amount is 
different, ICVERIFY may try to do an incremental authorization. It 
depends on whether this is supported by your processing network. For 
most host-based processing networks, the software dials out to the 
processing network when a ship transaction is performed for a book 
transaction.

Processing Debit Card Transactions
This section describes the processing functions available for handling debit card transactions, 
and how to set up your PINpad.

Processing a debit card transaction requires a card reader and an encrypted PINpad. ATM 
PINpads must be programmed by a bank before they can be used by ICVERIFY. Your PINpad 
must be a serial input PINpad, and must be Verifone 101, 1000, 201, 2000-compatible.

�No USB, parallel, SCSI, or keyboard PINpads are supported at this 
time.

Debit Card Transaction Types 
Like credit cards, authorized debit card transactions must be settled before the funds are 
transferred to your merchant account. The following transaction types are generally available:

• Sale— transfers funds from an ATM/debit account to your merchant account (used for 
all ATM/debit purchases)

• Void—removes an unsettled sale transaction from the open batch (used to remove a 
debit transaction prior to settlement) 

• Credit/Return/Refund—transfers funds from your account to an ATM/debit account 
(used to reverse a sale transaction that has been settled)
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For information on performing a sale transaction, see Sale, page 9. For information on 
performing a void transaction, see Void, page 10. For information on performing a 
credit/return/refund transaction, see Credit/Refund/Return, page 10.

� Book, Ship, Auth Only, and Force transactions are not used with debit 
card processing.

Setting Up a PINpad 
All debit card transactions require a PINpad. Your PINpad must be set up properly for it to 
function with ICVERIFY. 

ICVERIFY relies on proper system-level setup of the COM port to communicate properly with 
the PINpad. The COM port specified must also be properly configured in your Windows 
Control Panel. For virtually all PINpads, the proper values are 1200 baud, 7 data bits, even 
parity, one stop bit, and no flow control. These parameters must be set correctly or you will 
experience errors. 

To set up the PINpad for Windows 95/98/NT 4.0:

1. From the Start menu, choose Settings, and click Control Panel.
The Control Panel window is displayed.

2. Double-click System.
The System Properties dialog is displayed.

3. Click the Device Manager tab.

4. Beside Ports (COM & LPT), click + to display all ports available.

5. Double-click the COM port that is being used by the PINpad.
The <COM port name> Properties dialog is displayed.

6. Click the Port Settings tab, and make sure the settings are as follows:

• Bits per second—1200 

• Data bits—7 

• Parity—Even 

• Stop bits—1 

• Flow control—None

7. To save the settings and close the <COM port name> Properties dialog, click OK.

8. To close the System Properties dialog, click OK.



17
To set up the PINpad for ICVERIFY:

1. From the Edit menu, choose Options.
The Options dialog is displayed.

2. Click the Card Reader/Pinpad Setup tab. 

3. In the Device Type field, click the device type you are using.

4. In the Device Port field, specify the device port you are using.

5. Click OK.

About DUKPT PINpads
If you want to process debit card transactions, you need a PINpad that has already been 
properly encrypted by your processor or merchant bank with the processor’s configuration and 
key injection. Two common encryption formats that ICVERIFY supports are Masterkey 
(Mastercard’s debit key encryption format) and Derived Unique Key Per Transaction 
(DUKPT).

If you are using DUKPT encryption, when you are setting up your PINpad, you must also enter 
D in the Serial Type? field of the Hardware tab in Advanced Setup.

Processing Check Transactions
This section describes the processing functions available for handling check transactions.

A check transaction can be performed by using a driver’s license number, or by using Magnetic 
Ink Check Reader (MICR) verification.

Driver’s License Verification 
The driver’s license can be read using a three-track magnetic stripe reader attached to your 
system, or it can be entered manually in the interface. This function is used to approve a check 
that you have been presented with, and is designed to protect you from possible fraud. Use this 
function to ensure that the driver’s license does not appear on a list of driver’s licenses of 
people who have written bad checks. 

� This function does not guarantee available funds.
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� If your system includes a three-track magnetic stripe reader, and the 
customer has a magnetic stripe driver’s license, the license can be 
swiped to obtain this information.

MICR Verification 
The information encoded at the bottom of a check can be read by an MICR attached to your 
system, or can be entered manually in the interface. 

� Only keyboard check readers are supported.

The fields described in Table 1 are used when guaranteeing a transaction using a keyboard 
MICR check reader.

TABLE 1:  MICR CHECK GUARANTEE FIELDS

FIELD DESCRIPTION

Account Specifies the MICR number on the check (the reader 
automatically collects this information from the check).

ABA# Specifies the bank number on the check (the reader automatically 
collects this data from the check).

State Specifies the state that the customer lives in (it may be read from 
a magnetic stripe driver’s license if a three-track card reader is 
present).
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 CHAPTER 2 Using Offline Group 
Mode
If an immediate response from the processor is not necessary, Offline Group Mode is a 
very useful way of handling credit card transactions because it stores transactions for 
batch processing at a later time. This cuts down on transaction entry time because the 
operator does not need to wait for the software to dial out before entering the next 
transaction. It also cuts down on transaction processing time because the entire batch of 
offline group transactions can be submitted to the processing network with one phone call.

Understanding Offline Group Mode
When using Offline Group Mode, each transaction is stored in an offline group input file 
for future processing. You can use an application, such as a database or a spreadsheet, to 
create a file containing transaction data. This file can be imported into ICVERIFY for 
Windows by using the Import Transactions feature. For more information on importing 
transactions, see Importing Transactions, page 29.

Enabling Offline Group Mode
Before you can start storing transactions for offline processing, ICVERIFY must be in 
Offline Group Mode.

To enable Offline Group Mode:

1. From the Function menu, choose Off-Line Group Mode.
Offline Group Mode is enabled, with Off-Line replacing Real-Time in the 
ICVERIFY interface.
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Using Offline Group Mode
This section explains how to enter a transaction using Offline Group Mode.

Enter the transaction information as described in Processing Transactions, page 5. When you 
click Submit, the following message is displayed in the Response field:

OK: TRANSACTION ADDED TO BATCH 

The transaction has been stored in the offline group file for future processing. 

When you are ready to submit a batch of offline group transactions to your processing network, 
choose Transmit Off-Line Group from the Function menu. ICVERIFY submits the offline 
group transactions to the processing network. The number of transactions that can be sent in 
one batch varies by processor. 

Finding Transactions While Using Offline Group Mode 
The Find Transaction feature allows you to perform a search for a particular transaction.

� The Find Transactions feature is dependent on the operational mode of 
the software. If ICVERIFY is operating in Real Time Mode, the feature 
searches the transactions stored in the current open batch. When the 
software is operating in Offline Group Mode, you can use the feature to 
locate only offline group transactions. These are transactions that have 
been entered while in Offline Group Mode, but have not yet been 
submitted to the processing network for approval. 

Keep the following points in mind when you are searching for offline group transactions:

• The software must be set to Offline Group Mode.

• Once an offline group transaction has been transmitted to the processing network in a 
batch, it is no longer an offline group transaction. To find an offline group transaction 
once it has been transmitted, you must search for it in Real Time Mode.

• Training Mode transactions entered in Offline Group Mode are stored separately from 
all other offline group transactions entered. Search for these transactions by switching 
the software to both Offline Group Mode and Training Mode. 

For more information on performing a transaction search, see Processing Debit Card 
Transactions, page 15.
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Editing Transactions While Using Offline Group Mode 
Because offline group transactions are stored transactions that have not yet been transmitted to 
the processing network, you can edit them while they are stored in the offline group input file. 

�Make sure you have Offline Group Mode enabled before attempting to 
edit or delete any transactions.

To edit an offline group transaction:

1. Use the Find Transaction feature to locate the transaction you want to edit.

2. Select the transaction, and click Edit.
The transaction is displayed in the ICVERIFY interface.

3. Make the necessary edits.

4. From the Edit menu, choose Save Transaction.

OR

Choose Delete Transaction from the Edit menu to delete the transaction.
The Find Transaction dialog is displayed. 

� Choose Undelete Transaction to restore the transaction.

OR

Choose Stop Transaction Editing from the Edit menu to cancel the edit and return to 
the original transaction.
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 CHAPTER 3 Understanding 
Installment Billing
This chapter covers the following tasks associated with installment billing:

• adding an installment

• submitting an installment

Understanding the Installment Billing Feature
The installment billing feature is used in situations when a customer is billed the same 
amount on a recurring basis. For example, a health club that charges customers a regular 
monthly fee could use the installment billing feature to help automate the billing process. 

To access the installment billing feature:

1. From the Function menu, choose Installments.
The Manage Installments (used to add, edit, or delete an installment) and 
Transmit Installments (used to submit an installment) tabs are displayed. 

Adding an Installment
This section describes how to add, edit, and delete an installment using the Manage 
Installments tab. This is the first of two steps for processing an installment. Use the 
Transmit Installments tab to submit the installment to your processor. For more 
information on submitting your installment(s), see Submitting an Installment, page 26.

To add an installment:

1. From the Function menu, choose Installments.
The Manage Installments and Transmit Installments tabs are displayed. 
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2. Click the Manage Installments tab.

3. In the Customer Information area, type the customer’s credit card information.

� Currently, you will not have the ability to add Purchasing Card Level II 
and Level III supplemental information (for example, line item detail) 
while doing installments. As a result, your purchasing card transactions 
may be downgraded. Consult with your financial institution for 
questions about qualification.

4. In the Installment Information area, type the following information:

• Start Date—the date that you want ICVERIFY to begin tracking the installment record

� The specified start date MUST be one installment period prior to the 
actual date you want your first installment to run. For example, enter 
07-31-2001 for a monthly installment that is to be processed on 
08-31-2001.

• Payment Amount—the amount you are billing

• Tax Amount—the tax amount calculated

5. In the Number of Payments area, type the total number of payments the customer will 
be billed. 

OR

If you are billing the customer indefinitely, click Infinite Payments.
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6. In the Installment Period area, click one of the following:

• Annually—bills the same date the following year (for example, April 28 to April 28).

• Semi-Annually—bills six months later, on the same date (for example, April 28 to 
October 28). 

� If the date doesn’t exist, the following day is used as an alternate (for 
example, since September 31 doesn’t exist, an installment due on this 
date would become eligible for billing on October 1 instead). 

• Quarterly—bills three months later, using the same date as the initial billing date (if 
the date doesn’t exist, the next day will be used as an alternate)

• Monthly—bills one month later, using the same date as the initial billing date (if the 
date doesn’t exist, the next day will be used as an alternate)

• Semi Monthly—bills on the first and fifteenth of each month

• Weekly—bills on the same day as the start date on the following week (for example, 
every Tuesday)

• nnn days—bills at an interval of days that you specify

7. Click Add.
The new installment is displayed in the transaction list area.

To edit or delete an installment:

1. From the Function menu, choose Installments.
The Manage Installments and Transmit Installments tabs are displayed. 

2. Click the Manage Installments tab.

3. In the transaction list area at the bottom of the screen, double-click the installment you 
want to view.
The installment details are displayed.

4. Edit the necessary information, and click Save.

OR

Click Delete to remove the installment record from the list.

� To remove any changes to the original installment record, click Clear.
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Submitting an Installment
Customers will not be billed until the Transmit Installments tab is used to submit the 
installment(s) to the processing network. When installments are transmitted, ICVERIFY checks 
all of the installment records that have been created to determine which are due for billing. 
Those that are due will be submitted to the processing network in the form of a sale transaction 
(they still need to be settled after they have been approved). You can transmit installments as 
many times a day as necessary.

� Many processing networks have safeguards to prevent the approval of 
duplicate transactions. This places some limitations on installment 
billing, since sending more than one installment per day for any 
particular customer can result in a decline from the processing network. 
If you fall behind on transmitting installments for one or more 
customers, the software will transmit only the first past due installment 
when installments are transmitted. Any other past due installments will 
be eligible for transmission on subsequent days (but only one 
installment per customer may be transmitted on any given day).

�You must be in Real Time mode to transmit installments.

To submit an installment:

1. From the Function menu, choose Installments.
The Manage Installments and Transmit Installments tabs are displayed. 

2. Click the Transmit Installments tab.

3. Click Transmit.
The Transmit Transactions Monitoring area provides information to help you 
determine what happened during the transmission. Table 2, page 27, describes these 
fields.
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� Once all of the installments have been transmitted, you can use the Find 
Transactions feature to review the submitted installation results. For 
more information on the Find Transactions feature, see Finding Credit 
Card Transactions, page 7.

TABLE 2:  TRANSMIT TRANSACTIONS MONITORING FIELDS 

FIELD DESCRIPTION

Number Sorted Shows the number of installment records ICVERIFY checked to see if 
they are eligible for billing.

Total to Sort Shows the total number of installments that will be evaluated for 
eligibility in the current session.

Approved Shows the number of installments that have been approved by the 
processing network during the current session.

Not Approved/Not 
Due

Keeps a running total of the number of installments that have not 
been approved during the current session. This number is updated 
as installment transactions are being transmitted to the processing 
network. 

� This number also includes sorted records that are not eligible 
for billing at the time of transmission.

Current 
Transaction

Displays the status of the transaction that is currently being 
transmitted.

Transmit 
Transactions 
Progress

Displays the overall progress of the current session.
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 CHAPTER 4 Importing 
Transactions
This chapter covers the following tasks:

• building your import file

• importing your transaction file

About the Import Feature
If you have a database or spreadsheet program capable of exporting a batch of 
transactions, you can import it to ICVERIFY for Windows for processing. Once imported, 
these transactions are stored in an offline group input file for transmission to the processor 
at your convenience (if your offline group input file already contains transactions, the 
imported transactions will be appended to the transactions already in the file).

ICVERIFY requires that transaction data be presented in a rigidly-defined format in order to 
be successfully imported and processed. The import feature functions as an interpreter 
between your database or spreadsheet application and ICVERIFY, allowing you to specify 
the order in which the transaction fields are imported. The import feature then converts the 
transactions into the format that ICVERIFY requires for processing. Once this is complete, 
the imported transactions are submitted in the same manner as in Offline Group Mode. For 
information on offline group processing, see Using Offline Group Mode, page 19.
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Import Format and Fields 
ICVERIFY expects the transactions imported to be in a specific format in order for them to be 
imported successfully.

The following is an example of the information required for a basic sale transaction with no 
address verification information included. 

The text string shown above is generally referred to as a transaction record. Table 3, page 31, 
explains each component (numbered 1-6) in a transaction record. 

� Transaction record field names are processor specific and may be 
different depending on your processing network.

� A table of transaction record formats for retail and mail order (and 
descriptions of the fields used when creating them) are provided in 
Transaction Record Formats, page 71. 

"C1","ANNE","1429","431430196985032","0110","24.00"

1 2 3 4 5 6
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TABLE 3:  TRANSACTION RECORD COMPONENTS 

R
E

F
E

R
E

N
C

E
N

U
M

B
E

R

NAME DESCRIPTION

1 Transaction Type Contains a two-character command that tells 
ICVERIFY what type of transaction it will be 
processing. This information is for the program’s 
internal use only and is not passed to your 
processing network. The transaction in the example 
is a Sale (C1).

2 Clerk Field Contains the name of the clerk entering the 
transaction. ICVERIFY does not pass the information 
contained in this field to the processor. It is used for 
internal record keeping purposes only. 

� Some people have a database or spreadsheet 
that does not contain this information; however, 
it cannot be left out when building a transaction 
record. If your database or spreadsheet does 
not include a Clerk field, do not copy it to the 
Selected Fields box, or you will encounter 
errors. If the Clerk field is not selected for 
import, ICVERIFY will insert an empty Clerk field 
into the record created for the offline group input 
file so that it will be accepted by ICVERIFY.
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The file created by your application can contain a virtually unlimited number of transaction 
records, but each record must be separated by a carriage return. Following is an example of a 
file containing two sales transactions (C1) and one book transaction (C4). 

"C1","KATE","1429","4017750003100019","0109","17.25" 
"C1","RON","1432","5499740000000040","0012","141.00" 
"C4","BOB","1437","372233154021042","0205","91.87"

3 Comment Field Contains optional information, often an invoice 
number, which can be used later to pull up a 
transaction using ICVERIFY. This information is often 
transmitted to the processor, especially in the 
Restaurant, Mail Order, and Hotel credit card 
formats. This information may also show up on the 
customer’s credit card statements.

� Some people have a database or spreadsheet 
that does not contain this information; however, 
it cannot be left out when building a transaction 
record. If your database or spreadsheet does 
not include a Comment field, do not copy it to 
the Selected Fields box, or you will encounter 
errors. If the Comment field is not selected for 
import, ICVERIFY will insert an empty Comment 
field into the record created for the offline group 
input file so that it will be accepted by ICVERIFY.

4 Account Field Contains the customer’s credit card account number. 
Do not use any spaces or dashes when entering this 
number.

5 Expiration Date Contains the expiration date. This information is 
imported in MMYY format. If a slash is included 
between the month and the year (in other words, 
10/01 as opposed to 1001), the slash will 
automatically be removed as the transaction is 
imported. 

6 Amount Field Contains a dollar amount with the decimal included.

TABLE 3:  TRANSACTION RECORD COMPONENTS  (CONT.)
R
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E
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NAME DESCRIPTION
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� You can specify the order in which ICVERIFY reads the data exported by 
your application by arranging the transaction record components as you 
choose. 

You can choose to replace the C1 transaction type code with the word Sale. ICVERIFY 
automatically replaces the word Sale with its transaction type (C1) as part of the import 
process. 

� If you use this method, you will need to use the terminology that is 
specific to your processing network for the transaction that you want to 
process. Processor terminology for specific transactions can vary. 
Reference the tabs in the ICVERIFY interface for the terminology specific 
to your processor.

�When exporting transaction data from your database or spreadsheet 
application, make sure the application is not automatically formatting 
any of the fields (for example, inserting a dollar sign in front of the 
dollar amount).

Using the Import Transactions Dialog 
This section explains the features found in the Import Transactions dialog, which is used to 
import transactions from your database or spreadsheet application. This section explains the 
features found in this dialog.

To access the Import Transactions dialog:

1. From the File menu, choose Import Transactions.
The Import Transactions dialog is displayed. Table 4 describes the fields and buttons in 
the Import Transactions dialog.
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TABLE 4:  IMPORT TRANSACTION DIALOG FIELDS AND BUTTONS 

FIELD/BUTTON DESCRIPTION

Batch Displays the path to the offline group input file that your transactions 
will be imported to. This is the default path and filename defined by 
the Offline Group Input File field under the Merchant Info tab in 
Advanced Setup of ICVERIFY setup. The Browse... button allows 
you to import the transactions to a file other than the default offline 
group input file.

Available Fields Lists the available fields that can be used to define a transaction. 
Select each field necessary for the transaction that you will be 
handling, in the order that you have exported the transaction records, 
and click Add. This will add the field(s) to the Selected Fields area. 

Selected Fields Lists all of the fields that have been added from the Available Fields 
area. This is the field order that will be used when the transaction 
data is imported.

Copy Copies the field highlighted in the Available Fields area to the 
Selected Fields area.

Copy All Copies all the fields in the Available Fields area to the Selected 
Fields area. If you plan on using most of the available fields when 
importing your transactions, this button saves you the effort of 
copying fields to the Selected Fields area one at a time. You can the 
remove any extra fields by highlighting them and clicking Delete.

Up and Down 
buttons

Changes the position of a field displayed in the Selected Fields area. 
This allows you to make adjustments in the field order without 
clearing the Selected Fields area and starting from scratch. To 
change the position of a field in the list, highlight the field, then use 
the Up or Down buttons to move it to the desired position.

Delete Allows you to remove fields displayed in the Selected Fields area.

Save Allows you to save the field configuration that is currently displayed in 
the Selected Fields area. You will be able to specify the name of a 
configuration file containing the order and type of fields that were 
selected. This file will have an .imp extension. Once you have stored 
a field configuration, you can select that configuration by clicking 
Load. 
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Importing Transaction Data 
Export the transaction data from your database or spreadsheet application to a comma or 
quote-comma delimited file in one of the following formats, without column headings:

• .txt—Text file

• .csv—Comma Separated Variable file

• .prn—Tab delimited text file

• .mdb—Microsoft Access file

• .xls—Microsoft Excel file (versions 3, 4, 5, and 8)

• .dbf—DBASE file (versions 3, 4, and 5)

• .wk1, .wk3—Lotus 1-2-3 file

Once the file has been exported, you must set up your configuration file before you can import 
your transactions. The configuration file contains the field order of the transactions you are 
importing.

To set up your configuration file and import your transactions:

1. Run ICVERIFY. 

2. From the File menu, choose Import Transactions. 
The Import Transactions dialog is displayed. 

3. In the Available Fields area, add the fields of your transactions to the Selected Fields 
section.

Load Allows you to load a previously saved field configuration. A dialog 
opens that allows you to select the configuration that you want to use. 
Once you have selected the file that contains the configuration that 
you want, the fields for that configuration will be displayed in the 
correct order in the Selected Fields area.

Format Allows you to specify the type of file that will be imported. Files with 
the following extensions can be chosen for import: .txt, .csv, .prn, 
.mdb, .xls, .dbf, .wk1, .wk3

TABLE 4:  IMPORT TRANSACTION DIALOG FIELDS AND BUTTONS  (CONT.)

FIELD/BUTTON DESCRIPTION
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� You must copy the fields to the Select Fields box in the order that they 
appear in your database or spreadsheet. For example, the ICVERIFY 
default is as follows: Transaction Type, Clerk, Comment, Account 
number, and so on. Thus, if your database is Comment, Transaction 
Type, Account, Clerk, and so on, you cannot use the Select All button; 
you must manually select them one-by-one. 

4. Click Save.
The configuration is stored with the file name of your choice and the extension .imp. 

� You can save multiple configurations, which can then be accessed by 
clicking Load.

� To successfully import a batch that contains different types of 
transactions, you will need to add all the fields that are required by your 
processor for all of the transactions that you will be importing. 

5. From the Format menu, choose the format of the file you are importing.

6. Click Import. 
The Import File with Transactions dialog is displayed.

7. Select the file you created, and click Open.
If the file is imported successfully, you will receive a message indicating how many 
records were successfully imported.

OR

If the import was not successful, you receive an error message. Click Yes to view the 
Error page.

� The Error page lists only the transactions that were not imported from 
your database or spreadsheet. The first line of the error message 
contains the first record of the import that failed and the second line 
describes the nature of the error. All records in error are written to a 
file called ERRORS.TXT.
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Successfully imported transactions will be added to any transactions currently stored in the 
offline group input file. 

� The file you created in your spreadsheet or database application is not 
erased as a result of the import.
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 CHAPTER 5 Exporting 
Transactions
The Export Transactions feature can be used to export transaction data to a spreadsheet 
or database application. The data exported depends on the operation mode you are in. If 
you are processing transactions in real-time, all transactions currently in the open batch 
will be exported. If you are running in Offline Group Mode, transactions stored in the 
offline group output file will be exported. 

Exporting Transaction Data
This section describes how to export transaction data.

To export transaction data:

1. From the File menu, choose Export Transactions.
The Export Transactions dialog is displayed.

2. Click Credit, Debit, or Check, depending on the type of transactions you are 
exporting.

3. In the Available Fields area, click the detail you want to include in the export, and 
click Copy to move the detail to the Selected Fields area. 
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� You should copy the fields to the Select Fields box in the order that they 
appear in your database or spreadsheet. For example, the ICVERIFY 
default is as follows: Transaction Type, Clerk, Comment, Account 
number, and so on. Thus, if your database is Comment, Transaction 
Type, Account, Clerk, and so on, you cannot use the Select All button; 
you must manually select them one-by-one. 

4. Repeat Step 3 until the Selected Fields area contains all the details you want to include 
in the export.

� Use the Up and Down buttons to arrange the details in the order you 
want them exported if you didn’t copy them into the Selected Fields 
area in that order.

5. In the Text File Attributes area, click Include Field Names to include the selected field 
names as the first line in the export file.

6. In the Field Separation Character field, type the character you want to use to separate 
the field details. The default character is , (comma). 
Example: "C1","cmt...

7. In the Field Start/End Character field, type the character you want to use to separate 
each transaction field. The default character is " (quotation mark). 
Example: "C1","cmt...

8. In the Format area, choose the file format for your export.

� The Save button is used to save the field configuration displayed in the 
Selected Fields area. This file will have an .exp extension. The Load 
button is used to use a saved export format.

9. Click Export.
The Exported File with Transactions dialog is displayed.

10. Select the file to which you want to export the transactions, and click Save.
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Understanding the Processor Response Detail
The processor’s response can be exported by including Response in the Selected Fields area 
during export. 

� You can export responses for credit card transactions only.

The following is an example of a response from an approved transaction:

"Y12345612345678"

The Y at the beginning of the field indicates that the transaction was approved. This is 
followed by a six-digit approval code and an optional reference number.

The following is an example of a response from a declined transaction

"NPICK UP CARD"

The N at the beginning of the field indicates that the transaction was declined. This is followed 
by the text of the response from the processor.

If you have configured ICVERIFY for address verification using the Address Verification 
System (AVS), the software will return a one-character response that indicates how valid the 
address information is.

"Y123456Y12345678"

The Y between the approval code and the reference number indicates the address and five-digit 
ZIP code were correct for the credit card account information provided. For a list of possible 
AVS result codes, see Address Verification Result Codes, page 77. 

� Some processors require you to enter sales tax after a transaction has 
been approved. If this is true for you, and you have not included the tax 
amount in the original transaction, you will receive a Q instead of a Y 
(for example, Q123456Y12345678). This transaction has been 
approved by the processor; however, you may be downgraded due to not 
sending the tax amount.
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 CHAPTER 6 Generating Reports
You can create a variety of reports summarizing transaction activity using the Report 
function. With this function, you can create the following reports: 

• Credit Card 

• Debit Card 

• Check Guarantee 

• Settlement 

• Offline Group 

Creating a Credit Card Report 
A credit card report is used to view or print a summary of credit card activity for a 
specified date range, to match select data (customer, clerk, account, or card type), or to 
track credit activity for a defined period. 

� This report shows credit card activity only.

To create a credit card report:

1. From the Report menu, choose Credit Card.
The Credit Card Report dialog is displayed. 

2. Specify the parameters you want to include in your report, and click OK (Table 5, 
page 44) describes the fields displayed in the Credit Card Report dialog).
Your credit card report is created.
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TABLE 5:  CREDIT CARD REPORT FIELDS 

FIELD/BUTTON DESCRIPTION

Generate a report of 
Current Batch

Generates a report for the current batch transactions.

Generate a report of 
history transactions

Generates a report for settled batch transactions.

Starting Date and 
Ending Date

Sets the date range for your report. 

Include Details or Totals 
Only

Include Details generates a detailed summary report. Totals 
Only generates a summary report only.

� Only one of these options can be selected at a time. 

Sub Totals Displays settlement totals at each closing. 

All Transactions Includes all transactions in the report.

Select Categories Narrows the search criteria for your reports. The boxes in the 
first column are credit card types. The boxes in the second 
column are as follows:

• Captured—Lists all transactions that have been approved 
and can be settled. If you are searching for one specific 
card, make sure that the Captured checkbox is unchecked 
or you will get a report for the card that you have selected 
plus all other transactions that qualify as captured.

• Not Captured—Lists all transactions that cannot be settled 
directly, such as book or pre-authorization/auth only 
transactions.

• Errors—Lists all transactions that have been declined.

• Other—Lists inquiries.

• Serial # Seq—Lists all transactions regardless of status.

Matching Data Searches for a particular clerk, comment, card, or individual.

View Report Displays the report in a window.

Print Report Sends report to the printer that has been selected for report 
printing. To set up a report printer, choose Printer Setup from 
the File menu.
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Creating a Debit Card Report
A debit card report is used to view or print a summary of debit card activity for a specified date 
range, to match select data (customer, clerk, account, or card type), or to track debit activity for 
a defined period.

� This report shows debit card activity only.

To create a debit card report:

1. From the Report menu, choose Debit Card.
The Debit Card Report dialog is displayed. 

2. Specify the parameters you want to include in your report, and click OK. Table 6 
describes the fields displayed in the Debit Card Report dialog).
Your debit card report is created.

TABLE 6:  DEBIT CARD REPORT FIELDS 

FIELD DESCRIPTION

Generate a report of 
Current Batch

Generates a report for the current batch transactions.

Generate a report of 
history transactions

Generates a report for settled batch transactions.

Starting Date and 
Ending Date

Sets the date range for your report.

Include Details or Totals 
Only

Include Details generates a detailed summary report. Totals 
Only generates a summary report only.

� Only one of these options can be selected at a time. 

Sub Totals Displays settlement totals at each closing. 

All Transactions Includes all transactions in the report.
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Creating a Check Report
This section describes how to create a check report. The check report is used to view or print a 
summary of check activity.

To create a check report:

1. From the Report menu, choose Check Guarantee.
The Check Guarantee Report dialog is displayed. 

2. Specify the parameters you want to include in your report, and click OK. Table 7, page 
47, describes the fields displayed in the Check Guarantee Report dialog).
Your check report is created.

Select Categories Narrows the search criteria for your reports. The boxes in the 
first column are card types. The boxes in the second column 
are as follows:

• Captured—Lists all transactions that have been approved 
and can be settled. If you are searching for one specific 
card, make sure that the Captured checkbox is unchecked 
or you will get a report for the card that you have selected 
plus all other transactions that qualify as captured.

• Not Captured—Lists all transactions that cannot be settled 
directly, such as book or pre-authorization/auth only 
transactions.

• Errors—Lists all transactions that have been declined.

• Other—Lists inquiries.

• Serial # Seq—Lists all transactions regardless of status.

Matching Data Searches for a particular clerk, comment, card, or individual.

View Report Displays the report in a window.

Print Report Sends report to the printer set up to print reports. To set up a 
report printer, choose Printer Setup from the File menu.

TABLE 6:  DEBIT CARD REPORT FIELDS  (CONT.)

FIELD DESCRIPTION
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TABLE 7:  CHECK REPORT FIELDS 

FIELD DESCRIPTION

Generate a report of 
Current Batch

Generates a report for the current batch transactions.

Generate a report of 
history transactions

Generates a report for settled batch transactions.

Starting Date and 
Ending Date

Sets the date range for your report. 

Include Details or Totals 
Only

Include Details generates a detailed summary report. Totals 
Only generates a summary report only.

� Only one of these options can be selected at a time. 

Sub Totals Displays settlement totals at each closing. 

Floor Limit Lists transactions that were under the floor limit for that check 
processor.

� The floor limit is a dollar amount set by the processor in 
accordance with banking rules and regulations. When 
the amount of the purchase exceeds the floor limit, you 
must get permission from the card issuer to accept the 
card as payment for the transaction.

All Transactions Includes all transactions in the report.

Select Categories Narrows the search criteria for your reports. The boxes in the 
first column are credit card types. The boxes in the second 
column are as follows:

• Below Floor Limit—Lists all transactions that the amount of 
the check is below your specified floor limit.

• Captured—Lists all transactions that have been approved 
and can be settled. If you are searching for one specific 
check, make sure that the Captured checkbox is unchecked 
or you will get a report for the check that you have selected 
plus all other transactions that qualify as captured.

• Errors—Lists all transactions that have been declined.

• Other—Lists inquiries.

• Serial # Seq—Lists all transactions regardless of status.

Matching Data Searches for a particular clerk, comment, card, or individual.
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Creating a Settlement Report
This section describes how to create a settlement report. There are three types of settlement 
reports:

• Settlement—used to view or print a report of the last settlement/close batch procedure 
performed. It can be used to produce a hard copy of the settlement for filing.

• Settlement Error—used to view or print a summary of settlement errors for a single or 
multi-merchant ICVERIFY for Windows configuration. It displays any errors that 
occurred for the most recent settlement attempt.

• Settlement Preview—used to view your settlement/end-of-day transaction information 
before settling the batch.

Creating a Settlement or Settlement Error Report
To create a settlement or settlement error report:

1. From the Report menu, choose Settlement, then choose Result.
The Settlement Result Report dialog is displayed. 

OR

From the Report menu, choose Settlement, then choose Error.
The Settlement Error Report page is displayed. 

2. Click View Report or Print Report.
Your specified settlement report is created.

View Report Displays the report in a window.

Print Report Sends report to the printer set up to print reports. To set up a 
report printer, choose Printer Setup from the File menu.

TABLE 7:  CHECK REPORT FIELDS  (CONT.)

FIELD DESCRIPTION



49
� If you use a host-based processing network that auto-settles 
transactions, your processor settles your captured transactions at its day 
end—usually on a daily basis—without requiring you to perform a 
settlement/end day procedure. For host-based processing, ICVERIFY 
must internally “settle” captured transactions, transferring them from 
the open batch to the history files so it stays in synch with the processing 
network. This is generally done at one second past midnight; however, 
you can specify an autosettle time in the Merchant Information tab of 
the Setup dialog. Changing this setting will cause your reports to reflect 
different daily totals than reports from your processing network, and 
should not be done “lightly.” If you are using host-based processing, and 
you print a settlement report, it will contain only the previous day’s 
transactions.

Creating a Settlement Preview Report
You have the option to create a settlement preview report when performing your 
settlement/end-of-day procedure. It allows you to view a report of the transactions you are 
about to settle.

To create a settlement preview report:

1. From the Function menu, choose Settlement/End of Day.
The Settlement dialog is displayed.

2. Select Credit Card Report, and click Settlement Preview.
The Credit Card Report dialog is displayed.

OR

Select Debit Card Report and click Settlement Preview.
The Debit Card Report dialog is displayed.

3. Click View Report or Print Report.
Your Settlement Preview report is created.
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Creating an Offline Group Report 
This section describes how to create an offline group report.

There are three types of offline group reports:

• Group—includes the transactions in the current offline group (use this report when you 
want to view the group that is about to be transmitted)

• Result—includes the results of all offline groups transmitted since the last settlement.

• Duplicate—includes transactions in the current offline group that have matching card 
numbers

� This report includes only the first occurrence of a card. (For example, 
Card A is entered for $1.00 and then Card A is entered for $100.00. 
Only the $1.00 transaction will appear in the report.)

To create an offline group, offline group result, or offline group duplicate report:

1. From the Report menu, choose Off-line Group, then choose Group.
The Off-Line Group Report dialog is displayed. 

OR

From the Report menu, choose Off-line Group, then choose Result.
The Off-Line Group Result Report dialog is displayed.

OR

From the Report menu, choose Off-line Group, then choose Duplicate.
The Off-Line Group Duplicate Report dialog is displayed. 

2. Click Default to view the Offline Group Input file transactions specified in the 
Merchant Info section of the Setup interface.

OR

Click Select to specify an input file you want to create a report for.

3. Click View Report or Print Report.
Your specified offline group report is created.
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 APPENDIX A E-Commerce Security
The security of your data should always be an important consideration when running your 
company.  Just as you take precautions with your physical business through locks, security 
systems, and other mechanisms, it is important that you take similar precautions in transacting 
business on the Internet.

ICVERIFY may be used to send transactions over the Internet, provided the user has 
implemented security measures (firewalls, encrypted files, and so on)  appropriate to the user’s 
intended use. E-commerce transactions require an inherently higher level of security than 
transactions that originate in a retail environment or over the telephone. Security of 
transactions and transaction data is the responsibility of the user and is beyond the scope 
of ICVERIFY support. Consult with a security expert if you have any questions about how to 
configure your system for e-commerce transactions. 
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 APPENDIX B ICVERIFY Command 
Line Options
There are a number of command line parameters that can be used with ICVMLT32.EXE. These 
commands (with the exception of /A) are entered into the Initialization String field when 
loading the program. 

Command Line Parameters
This section describes command line parameters that can be used with ICVMLT32.EXE.

� The /P command discussed below can be used with both ICVMLT32.EXE 
and ICVERIFY.EXE.

/A
Once ICVMLT32.EXE has been initialized at least once, the /A argument will cause 
ICVMLT32.EXE to automatically initialize using the same settings that were used the last time 
that the program was initialized manually. This switch should not be used in the Initialization 
String field. Instead, create a shortcut to run ICVMLT32.EXE, then append the /A to the 
command line in this fashion:

C:\ICVWIN\ICVMLT32.EXE /A

� The example above assumes that ICVERIFY for Windows was installed to 
C:\ICWIN. 
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/DD
The /DD command line parameter can be used in the Initialization String field to place 
ICVMLT32.EXE into Training Mode. When the /DD command is used, ICVMLT32.EXE will treat 
all transactions it receives as Training Mode transactions, and process them accordingly. This 
command line parameter is generally used only when testing an integration between ICVERIFY 
and another application. If you want to place the GUI into Training Mode, choose Options 
from the Edit menu, and then click Training Mode (this will affect only the substation where 
Training Mode was selected).

� When in Demo Mode, the ICVERIFY batch and history files will be 
named icvtrai*.*.

D/
The /D command line parameter provides the same functionality as the /DD parameter, except 
the ICVERIFY open batch and history files are named icvdemo*.*.

/P
This command line parameter can be used to load a setup file other than the default. This is 
sometimes useful in testing and multi-merchant setups. The syntax for this command line 
parameter is as follows:

/P [Set File Name] 

where [Set File Name] is the name of the set file to be loaded. To load ICVMLT32.EXE using 
ICVE0005.SET, type the following into the Initialization String field:

/P ICVE0005.SET

The /P switch can be used with ICVERIFY.EXE by creating a shortcut and appending the switch 
and set file name to the command line in the same manner as shown above. 

� When specifying the setup file name, the .SET extension must be 
specified or the setup file will not be loaded.

/O
This command line parameter forces the program to use the short, evaluated response when 
returning the response from the processing network. This response type is required from 
ICVMLT32.EXE by the substations for a multi-user setup to function properly. The response type 
can also be configured in the setup file by using the Evaluate Rsp (Y/N/B/L/D/S) field under 
the Merchant Information tab in Advanced Setup. 
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/O[x]
The optional x causes ICVMLT32.EXE to return the original request on the first line and the 
short, evaluated response to the request on the second line.

/XX
The /XX parameter can be used to force ICVMLT32.EXE into debug mode. All program activity 
will be logged to a file called ICVERIFY.DBG, which will be located in the directory where the 
program files have been installed. This file is often used for software troubleshooting; 
however, the information it contains is in a highly technical format.
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 APPENDIX C Modem Troubleshooting
� Your modem must be correctly configured for your operating system, or 
it may not perform correctly when running ICVERIFY for Windows.

This appendix contains troubleshooting tips for the following two potential modem difficulties.

1. You are able to establish connection with your processor, but you are receiving incorrect 
information or rejection of all transactions.
This most likely means that you did not input the correct information in your processor 
setup. If this occurs, attempt to rebuild your setup file or contact your merchant help 
desk to confirm your merchant account information.

2. You are unable to establish a connection to your processor.
Most likely, one of the following three things is occurring:

• Another application has control of the modem.

• The port information in the modem port field is not set correctly.

• The dial string is not correct for that modem. 

To troubleshoot your modem:

1. Be sure the modem is working. 
Try using another communication program to dial out with your modem. If other 
software fails to connect, make sure your modem has been installed properly. 

� This includes both the physical installation and plug connections, as 
well as the process of adding this hardware device to your Windows 
Add New Hardware Control Panel. Also, confirm with your modem 
manufacturer that you have the correct drivers for your modem.
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2. If you are using an external modem, verify that it is correctly plugged in to the phone 
line, power source, and computer.
Verify that the lights flash when the computer is attempting to communicate with the 
modem. 

3. Check if any other applications are using the modem. 
If they are, shut them down, restart ICVERIFY, and try again. If the modem is still not 
working (but other applications have no problem accessing the modem), the problem is 
most likely a port or dial string setting issue.

4. Check the modem port setting.

To check the modem port setting:

� This procedure is for Windows 98 and Windows ME users, only.

1. From the Start menu, choose Settings and click Control Panel. 

2. Double-click Modems.
The Modem Properties dialog is displayed.

3. Click the Diagnostics tab, and highlight your modem.

4. Click More Info. 
Information about your modem is displayed. 

5. Copy the COM port #, interrupt, and address information.

6. Run the ICVERIFY setup program. 

7. Click the Hardware tab. 

8. In the Modem Port field, type the COM port # value. 
If the hardware settings for your modem appear to be correct, and the steps listed above 
did not get the modem to dial, try changing the dial string. 

To change the dial string:

1. Open Advanced Setup, and click the Hardware tab.

2. View the Modem Port field, and record the dial string.

3. Delete the dial string, and enter ATDT.
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� These four characters should initialize just about every modem under 
normal circumstances. However, this dial string is generally used for 
diagnostic purposes only, and may not supply a consistent connection to 
your processing network.

4. Save the changes and close Advanced Setup. 

5. Restart ICVERIFY and try another test. 

� If this doesn’t work, shut down all programs that are running, and shut 
down your computer. Turn the computer back on, start ICVERIFY, and try 
another test. (Before attempting the test, be sure to shut down any other 
applications that are using the modem.) 

If the modem is dialing out when a transaction is submitted, then it is most likely a dial string 
issue. Almost all processing networks use generic 1200 baud modems, which are programmed 
to disconnect if there is extra data during the initial handshaking. Newer modems use a number 
of advanced features that are intended to provide a more reliable connection. They are also 
designed to communicate at speeds much greater than 1200 baud. 

When a newer modem using data compression, error correction, flow control, or high-speed 
communications connects to another modem, it tries to match the features of that modem. 
Modems used by processing networks do not have the features necessary to correctly interpret 
the data sent as part of this negotiating process, and will pass this information along to the 
network as part of the data stream. The processor will not recognize this data and immediately 
terminate the connection. Contact your modem manufacturer to request a dial string that will 
disable the following features:

• Data Compression

• Error Correction

• Flow control

The dial string should have a command forcing it to use the Bell 212a communications 
protocol at 1200 baud. Baud rates should be set to 1200 in the Credit Cards setup tab.

� Many check processing networks process at speeds as low as 300 baud. 
For those, the dial string should support a Bell 103 standard 
communications protocol at 300 baud. Baud rates should be set to 300 in 
the Check Guarantee setup tab.
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� If the dial string generated by the Auto-Detect feature or by choosing 
your modem from the list in the Auto-Detect field contains back quotes, 
do not remove them.
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 APPENDIX D Menu Descriptions
This appendix describes the menu options in the ICVERIFY for Windows interface. The 
following menus are available in ICVERIFY:

• File

• Edit

• View

• Function

• Report

• Utilities

• Help

File Menu 
Table 8 describes the options available on the File menu.

TABLE 8:  FILE MENU OPTIONS 

MENU OPTION DESCRIPTION

Import 
Transactions

Allows the user to import a batch of credit card transactions created by 
another application (see Importing Transactions for more details).

Export 
Transactions

Allows the user to export credit card, debit card and check guarantee 
transaction data for use by another application such as a database or 
spreadsheet (see Exporting Transactions for more details).

Print Receipt Allows the user to print a receipt for any transaction that is currently 
being viewed.
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Edit Menu 
Table 9 describes the options available on the Edit menu.

Printer Setup Defines the report and/or receipt printer that will be used by ICVERIFY. 

Save 
Installments

Allows the user to save a new installment or an existing installment that 
is currently being edited.

Exit Closes ICVERIFY.

TABLE 9:  EDIT MENU OPTIONS 

MENU OPTION DESCRIPTION

Undo, Cut, 
Copy and 
Paste

These are all standard Windows functions that can be used while editing 
transactions.

Find Current 
Transaction

Locates and edits current transactions (approved transactions that have 
not been settled or Offline Group transactions that have not been 
submitted to the processing network). 

Save 
Transaction

Saves a transaction that is currently being edited.

Delete 
Transaction

Deletes a transaction that is currently being edited.

� This deletes a transaction out of the ICVERIFY open batch file, and 
not at the processing network. To reverse the transaction at the 
processing network, use the Void feature, instead.

Stop 
Transaction 
Editing

Stops transaction editing without saving any changes to the transaction 
that is currently being edited. 

TABLE 8:  FILE MENU OPTIONS  (CONT.)

MENU OPTION DESCRIPTION
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View Menu
Table 10 describes the options available on the View menu.

Options Opens a tabbed dialog that lists various options for configuring 
ICVERIFY.

Transactions 
List

Allows you to customize the order in which transactions tabs are 
ordered and displayed in the interface and allows you to hide transaction 
tabs. 

� Hiding transaction tabs is useful if you want to limit the transaction 
processing abilities of substations or employees.

TABLE 10:  VIEW MENU OPTIONS 

MENU OPTION DESCRIPTION

Status Bar Allows you to choose whether or not the status bar will be displayed. The 
status bar is the bar running along the very bottom of the user interface. 

The status bar displays some information about the item the user has 
currently selected, and also contains the Clock Pane (the date/time 
display at the right end of the status bar).

Credit Card 
Form

Switches to the Credit Card Form.

� This is disabled if you are not configured for processing credit card 
transactions.

Debit Card 
Form

Switches to the Debit Card Form.

� This is disabled if you are not configured for processing debit card 
transactions.

Check 
Guarantee 
Form

Switches to the Check Guarantee Form.

� This is disabled if you are not configured for processing check 
transactions.

TABLE 9:  EDIT MENU OPTIONS  (CONT.)

MENU OPTION DESCRIPTION
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Function Menu 
Table 11 describes the options available on the Function menu.

� Depending on the processor you are using, the names of the fields in the 
Function menu may differ.

TABLE 11:  FUNCTION MENU OPTIONS 

MENU OPTION DESCRIPTION

Convert Book To 
Ship

Finds and converts approved book transactions to ship transactions.

Settlement/End 
Day

Performs the settlement/end of day process, or previews the batch 
before settlement.

Switch 
Merchants

Switches merchants when ICVERIFY is in Multiple Merchants Mode.

Off-Line Group 
Mode

Toggles Offline Group Mode off and on. Offline group transactions are 
stored in an offline group input file for batch transmission to the 
processing network For more information, see Using Offline Group 
Mode, page 19.

Transmit Off-
Line Group

Transmits all transactions stored in the default offline group input file. 
A non-default file may also be selected. For more information, see 
Using Offline Group Mode, page 19.

Installments Loads the installment (recurring billing) selections. For more 
information, see Understanding Installment Billing, page 23.
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Report Menu
Table 12 describes the options available on the Report menu.

Transmit 
Authorization 
Requests

� This menu item is displayed only when you are set up to process 
American Express transactions directly through American 
Express.

American Express uses a special batch format to handle transactions 
that include address verification information. It is used to transmit 
American Express transactions with address verification information 
directly to American Express in batch mode. Once these transactions 
have been submitted, you must wait about five minutes and then use 
the Retrieve Authorization Responses selection described below to 
obtain the response from American Express. ICVERIFY will wait the 
required period and then display a dialog prompting you to use the 
Retrieve Authorization Responses selection to obtain the response 
from American Express.

Retrieve 
Authorization 
Responses

� This menu item is displayed only when you are set up to process 
American Express transactions directly through American 
Express.

Retrieves responses for American Express transactions that were 
submitted using the Transmit Authorization Requests selection 
described above.

TABLE 12:  REPORT MENU OPTIONS 

MENU OPTION DESCRIPTION

Credit Card Prints a report of credit card activity. For more information, see 
Creating a Credit Card Report, page 43.

Debit Card Prints a report of debit card activity. For more information, see Creating 
a Debit Card Report, page 45.

Check 
Guarantee

Prints a report of check guarantee activity. For more information, see 
Creating a Check Report, page 46.

TABLE 11:  FUNCTION MENU OPTIONS  (CONT.)

MENU OPTION DESCRIPTION
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Utilities Menu 
Table 13 describes the options available on the Utilities menu.

Settlement Prints a report of the last settled batch. For more information, see 
Creating a Settlement Report, page 48.

Offline Group Provides access to several offline group report options. For more 
information, see Creating an Offline Group Report, page 50. 

TABLE 13:  UTILITIES MENU OPTIONS 

MENU OPTION DESCRIPTION

Ymodem File 
Send

Allows you to transmit a specified file to a specified phone number 
using the Ymodem format. This test is often used by merchants setting 
up for American Express.

� It is not necessary to provide an outside line prefix here if you have 
already entered one in your ICVERIFY setup program.

Substation Test Sends a test sequence to the master station to make sure that it is 
responding correctly. The substation test is used after the software has 
been configured to act as a substation in a multi-user setup. Make sure 
the substation and master station are both pointed to the directory that 
will be used for the exchange of transaction requests and responses. If 
the substation and master station are pointing to different directories, 
the software will not run.

Delete Partial 
Off-Line Group

Deletes the tracking file that is used to keep the position in the offline 
group file. This function is used when an offline group transmission has 
failed.

� Do not use this function unless instructed to do so.

Reset Batch Allows you to reset the number of the current batch. Under normal 
conditions, this feature is not used. It is recommended that you do not 
reset the current batch number unless you have been instructed to do 
so by a technician.

TABLE 12:  REPORT MENU OPTIONS  (CONT.)

MENU OPTION DESCRIPTION
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Clear Batch When selected, ICVERIFY transfers the transaction data from the open 
batch to the history files without dialing out. 

� Do not use this function unless you are certain that your current 
open batch has already been settled by your processing network.

Delete Current 
Batch

Clears the current batch of all transactions. It is normally used only 
during testing with test account setup information.

� This does not delete any transactions currently captured at the 
processing network. If you want to void your entire batch, you 
should either use the Void function on all transactions (one-by-
one), or call your processing network to see if your current open 
batch can be deleted.

Find Settled 
Transaction

Finds settled transactions stored in the ICVERIFY history files. It is most 
commonly used when a merchant wants to print a receipt for a settled 
transaction.

� Settled transactions cannot be located using the Find Current 
Transaction menu option (accessed from the Edit menu) 
because it only searches for unsettled transactions stored in the 
current open batch or Offline Group Input file. 

Password... Allows you to set password protection of various menu selections. It is 
also possible to create a password for the entire application. 

If you use this feature, it is strongly suggested that you keep copies of 
your password(s) in a safe place to help ensure that you do not get 
locked out of a password-protected feature or the program itself.

TABLE 13:  UTILITIES MENU OPTIONS  (CONT.)

MENU OPTION DESCRIPTION
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Help Menu
Table 14 describes the options available on the Help menu.

Remove 
Password

Removes password protection for the selected item.

Customer 
Database

 ICVERIFY features a customer database that can be used to store 
information about regular customers. This information can be used to 
populate fields on the GUI by selecting the cardholder’s name from the 
Customer Name menu. 

� If the checkbox at the bottom of the dialog is checked, you will be 
asked if you want to create a database entry each time that 
payment information is manually entered for a cardholder that 
does not already have an entry in the customer database. 

� The only fields that are required when creating a record are the 
Account Number, Exp Date and Customer Name fields. Only 
the account number and expiration date will be retained from 
swiped credit cards.

TABLE 14:  HELP MENU OPTIONS 

MENU OPTION DESCRIPTION

Help Loads the online Help file, which can also be accessed by pressing F1.

Tip of the Day Displays the Tip of the Day window, which is normally displayed when 
the program is first loaded.

Tooltips Enables or disables the Help that appears when a cursor is placed 
over an object.

Context-
Sensitive Help

Determines whether the context-sensitive Help tab is active or inactive. 
If this item is not checked, the Help tab will not be updated when it is 
selected.

About 
ICVERIFY

Displays information about the version of ICVERIFY that is currently 
being used and the product serial number. 

� The Merchant Information button allows you to view your 
merchant configuration information.

TABLE 13:  UTILITIES MENU OPTIONS  (CONT.)

MENU OPTION DESCRIPTION
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 APPENDIX E Transaction Record 
Formats
The transaction record formats in this appendix are provided as a guideline for importing 
transaction data from another application. These formats are correct for most credit card 
networks and options. The most common names are used in the tables in this appendix. The 
first column is a literal transaction type indicator (C1,C2, and so on.). The remaining columns 
are defined in Field Descriptions, page 74. 

� A small number of special options are not included in this appendix. If 
you are a member of the ICVERIFY Integration Partnership Program 
(IPP), refer to your Software Developer Kit (SDK) CD for more 
extensive information.

Table 15, page 72, lists the transaction record formats for retail charge card formats. A ✔  
(check mark) in a column indicates that format is used for that type of transaction.
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� In a force transaction, the ZIP & ADD formats are optional, and for 
record keeping purposes.

Table 16, page 73, lists the transactions record formats for the mail order charge card 
authorization formats. A ✔  (check mark) in a column indicates that format is used for that type 
of transaction.

TABLE 15:  RETAIL CHARGE TRANSACTION RECORD FORMATS 
TR

A
N

S
A

C
T

IO
N

TY
P

E
 IN

D
IC

A
T

O
R FIELDS

CMC CMM ACT EXP AMT APV ZIP ADD

Sale C1 ✔ ✔ ✔ ✔ ✔ ✔ ✔

Void C2 ✔ ✔ ✔ ✔ ✔ ✔

Credit/
Return

C3 ✔ ✔ ✔ ✔ ✔

Credit 
Void

CR ✔ ✔ ✔ ✔ ✔ ✔

Force C5 ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Auth 
Only

C6 ✔ ✔ ✔ ✔ ✔ ✔ ✔
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� In a force transaction, the ZIP & ADD formats are optional, and for 
record keeping purposes.

TABLE 16:  MAIL ORDER CHARGE TRANSACTION RECORD FORMATS

TR
A

N
S

A
C

T
IO

N

TY
P

E
 IN

D
IC

A
T

O
R FIELDS

CMC CMM ACT EXP AMT APV ZIP ADD

Book C4 ✔ ✔ ✔ ✔ ✔ ✔ ✔

Ship CO ✔ ✔ ✔ ✔ ✔ ✔ ✔

Sale C1 ✔ ✔ ✔ ✔ ✔ ✔ ✔

Void 
Sale

C2 ✔ ✔ ✔ ✔ ✔ ✔

Credit/
Return

C3 ✔ ✔ ✔ ✔ ✔

Credit 
Void

CR ✔ ✔ ✔ ✔ ✔ ✔

Force 
Sale

C5 ✔ ✔ ✔ ✔ ✔ ✔ ✔ ✔

Auth 
Only

C6 ✔ ✔ ✔ ✔ ✔ ✔ ✔
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Field Descriptions
Table 17 describes the fields used in the record formats. For more information about 
transaction record formats, see Transaction Record Formats, page 71.

For a description of the numbers contained in the Field Type column, see Table 18, page 76.

TABLE 17:  FIELD DESCRIPTIONS 

FIELD ID MIN LEN MAX LEN
FIELD 
TYPE FIELD DESCRIPTION

ABA  9  9  0 ABA Number

ACT  6 19  0 Credit card account number

ADD  0 20  1 Address (optional field)

AMN  0 13  5 Amount of additional cash (cash-
back)

AMT  0 13  5 Amount of purchase

AMt  0 13  5 Total amount

APV  2  6  1 Approval code

CKN  2  6  0 Check number

CHo  3 16  0 Account number 

CH2  2 25  0 Account number

CMA 10 10  2 Check-in date (format: 
MM/DD/YYYY)

CMc  0 32  1 1st field (clerk)

CMD 10 10  2 Departure date (format: 
MM/DD/YYYY)

CMe  2  2  1 State code

CME  0  7  5 Additional charges

CMI  0  6  0 Invoice/folio number

CMM  0 32  1 2nd Field (comment)

CMN  0 20  1 Customer name

CmP  1  1  3 Preferred cardholder (Y/N)?

Cmr  0 13  5 Room rate

CMS  0 20  1 Server ID
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CMT  0 20  1 Ticket ID

DOB 10 10  2 Date of birth

DLn  4 30  1 Driver’s license number

EDT 10 10  2 Ending date (format: MM/DD/YYYY)

EXP  3  4  0 Expiration date (YYMM only; may 
also hold card swipe)

HRD  1  1  3 Printer? (Y/N)

MID  0  4  1 Merchant ID

MTD  0 30  1 Message of the day

NUL  0  0  - Null field

PIN 16 16  1 Encrypted PIN number as returned 
from the pin pad

REF  7  8  0 Reference number

RPS  0 10  4 Report options

SDT 10 10  2 Starting date (format: MM/DD/YYYY)

STE  2  2  1 State code

SUM  1  1  3 Summary? (Y/N/S/D)

SWP  0 38  1 Swiped card information (track 2 
only)

TAG  1  1  3 Print receipts? (Y/N)

TIP  0 13  5 Amount of tip

ZIP  5  9  1 ZIP code (optional field)

TABLE 17:  FIELD DESCRIPTIONS  (CONT.)

FIELD ID MIN LEN MAX LEN
FIELD 
TYPE FIELD DESCRIPTION
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Table 18 describes the numbers listed in the Field Types column in Table 17, page 74.

TABLE 18:  FIELD TYPES

NUMBER DESCRIPTION

0 Numeric

1 Alphanumeric

2 Date (MM/DD/YY)

3 Y or N

4 Report type

5 Currency
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 APPENDIX F Address Verification 
Result Codes
Use the address verification codes in Table 19 when you are exporting transaction data to a 
database or spreadsheet. 

TABLE 19:  ADDRESS VERIFICATION RESULT CODES 

LETTER 
CODE DESCRIPTION FUNCTION

A Address Address matches; ZIP code does not match

E Edit Error Address verification not available for this transaction

G Not available 
global

AVS information is not available; card appears to be 
issued by a non-U.S. financial institution

N No Neither address nor ZIP code match

R Retry System unavailable or timed out

U Unavailable Address information is unavailable; this card is issued by 
a U.S. financial institution

W Whole ZIP Nine-digit ZIP code matches; address does not match

X Exact Address and nine-digit ZIP code both match

Y Yes Address and five-digit ZIP code match

Z ZIP Five-digit ZIP code matches; address does not match
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 APPENDIX G Program Messages and 
Files
This appendix describes the program messages and files produced by ICVERIFY for Windows.

Messages
ICVERIFY generates a number of messages that either explain the operation being performed, or 
warn that an error has occurred. Table 20 lists the messages that ICVERIFY produces.

TABLE 20:  PROGRAM MESSAGES 

MESSAGE DESCRIPTION

’APPROVED:’ + {Approval 
Code Number} + [REF# 
X1234567] 

The transaction is approved, with the displayed approval 
code (and, in some cases, a reference number).

’APPROVED: UNDER 
FLOOR LIMIT #’ 

No dialup is necessary; the amount is under the floor limit.

’BATCH DEBIT ENTRIES 
NOT ALLOWED’

You cannot process a debit card transaction while in Batch 
Mode.

’BUSY’ The phone number the modem is dialing is busy.

’CALLING’ The modem is dialing the card processor.

’CORRUPTED 
TRANSACTION FILE’ 

There are inconsistencies in the transaction file. 

’CUSTOMER CANCEL’ The customer has pressed the CANCEL key on the pinpad.
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’FILE BUSY! RETRYING, 
ESC TO STOP’ 

A file needed by ICVERIFY is in use. The program will 
continue to retry until you press ESC.

� This is a Novell network error.

’FILE ERROR 0: [FILE 
NAME]’ 

The program control file [FILE NAME] is not present.

’FILE OPEN ERROR’ + 
[message] 

The message may be one of the following: 

119 Disk is Full 
Invalid Path [check ICSETUP] 
Directory Full Bad Filename [invalid character] Access 
Denied 
Path Not Found 
Disk Not Ready [Floppy Disk or Hard Disk error, or network 
setup problem]

’INVALID ACCOUNT 
NUMBER’ CHECKING 
message: 

The number you entered is not a valid checking account 
number.

’INVALID CARD #’ The number you entered did not pass the test for a valid 
card number. There may be a typo—check the number, and 
correct your entry. Another problem may be that the card 
that was passed through the card reader is not an 
acceptable card for this type of transaction on your system, 
or you are not set up to accept this card type. 

'INVALID SUBSTATION'  ICVERIFY/Sxxx has been entered with a substation ID (xxx) 
not licensed on the system.

'LRC ERROR' A communications LRC error has occurred (the system will 
retry).

'MODEM NOT 
RESPONDING'

An incorrect port, invalid modem string, or phone number is 
being used.

'NO CARRIER' The communications line has dropped. Retry the 
transmission.

'NO DIALTONE' The modem did not receive a dial tone when attempting to 
dial. Check the phone connection.

'NO TRANSACTIONS ON 
FILE!' 

There are no transactions on file for the report you have 
selected.

'NOT APPROVED' + 
[message] 

The transaction has not been approved.

TABLE 20:  PROGRAM MESSAGES  (CONT.)

MESSAGE DESCRIPTION



81
’NOTHING PENDING’ There are no pending installment transactions.

� This is an installments error.

’PINPAD ERROR’ A pinpad error message indicates an invalid parameter or 
setting in the operation of the pinpad, the Track 3 reader, or 
the signature pad. One of the following messages may also 
appear: 

1. ’INVALID Port #’ 
2. ’INVALID Baud’ 
3. ’INVALID Parity’ 
4. ’INVALID Stop Bits’
5. ’INVALID Data Bits’ 
6. ’INVALID Buffer’ 
7. ’INVALID Open’ 
8. ’INVALID String’ 
9. ’INVALID UART’ 
10. ’INVALID Never Opened’ 
11. ’INVALID ERROR:’ {Error Number}

’PINPAD MISSING OR NOT 
WORKING’ 

 ICVERIFY has not found a working pinpad at the pinpad 
port indicated in your setup file. Correct the pinpad or 
pinpad port before proceeding with debit card entry.

� This is a debit card error.

’PINPAD MISSING OR NOT 
WORKING; USE PINPAD? 
(Y/N)’ 

 ICVERIFY has not found a working pinpad at the pinpad 
port indicated in your setup file. You can type Y to select 
manual card number entry you can correct the pinpad or 
pinpad port before proceeding.

’PORT’ {Port I.D.} ’SETUP 
INVALID’ 

The modem and/or pinpad port indicated in your setup file 
is not a valid port on your computer system. 

’REQUEST TRANSMITTED’ This message is issued at the substation, when the master 
station has started to process a request.

� This is a multi-user processing error.

’RESPONSE’ (Approval Code or other message) During an Offline Group 
transmission, each transaction number is displayed while it 
is being transmitted, followed by the above message.

’SIGNATURE COMPLETE? 
(Y/N)’ 

During Signature Capture, the operator enters Y when the 
customer is finished signing the signature pad.

TABLE 20:  PROGRAM MESSAGES  (CONT.)

MESSAGE DESCRIPTION
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Files
Table 21 describes the program files associated with ICVERIFY. Supplemental files are denoted 
by a ✔  (check mark).

’SYSTEM DATE WAS NOT 
SET!’ 

The current operating system date is invalid. Set the 
system date to the current date and restart ICVERIFY.

’TIME OUT’ The modem has failed to connect to the processor or the 
processor has not responded before the time set in 
Hardware setup (Wait time for connect). Additional 
reasons may be given.

’TRANSACTION NOT 
FOUND’ 

The transaction entered was not found in the current file. If 
you are trying to void, a credit entry may be required.

’WAITING FOR ANSWER’ The modem is waiting for an answer at the card processor 
number. Press ESC to cancel the transaction.

’WAITING FOR NETWORK 
RESPONSE’ 

This message is part of the communication procedure 
when dialing the host. ICVERIFY is waiting for the card 
processor to respond.

TABLE 21:  PROGRAM FILES 

FILE DESCRIPTION
SUPPLEMENTAL 
FILE

DEMOxx.SET Demonstration SET files ✔

DEMOACT.DEM Allows card swipe simulations using 
CTRL+ALT+X

✔

FILELIST.DOC File listing ✔

GUI32HLP.HLP  ICVERIFY Graphical User Interface Help

GUIDBASE.MDB Microsoft Access internal support 
database

ICSETUP.CDE Parameter-field code definition file

ICSETUP.DAT Internal support data file

ICSETUP.EXE  ICVERIFY Setup Configuration Utility

TABLE 20:  PROGRAM MESSAGES  (CONT.)

MESSAGE DESCRIPTION
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ICVAPI.DLL Internal support DLL

ICVDLL16.DLL Win16 Credit DLL

ICVDLL32.DLL Win32 Credit DLL

ICVDLL32.LIB Win32 library file ✔

ICVERIFY.AUT Internal support data file

ICVERIFY.CDE Parameter-field code definition file

ICVERIFY.DAT Internal support data file

ICVERIFY.DLL  ICVERIFY Graphical User Interface 
resource DLL

ICVERIFY.EXE  ICVERIFY Graphical User Interface 
Application 

ICVERIFY.HLP  ICVERIFY Help file

ICVERIFY.MDM Modem support file

ICVERIFY.MSG Displayed message file

ICVERIFY.MSH Internal support data file

ICVERIFY.PHN Commonly accessed phone numbers

ICVERIFY.VER  ICVERIFY version file

ICVMLT32.EXE  ICVERIFY Multi-User Master Application 

ICVOLE32.EXE Visual Basic OLE Object ✔

ICVUPG.EXE  ICVERIFY Upgrade Wizard

INSTALL.LOG Installation Log

MLT32HLP.HLP  ICVERIFY Multi-User Master Help

README.DOC Release Notes ✔

SETUP.HLP Online help for the setup program

TIPS.TXT  ICVERIFY Help file

DAO350.DLL DAO version 3.5

TABLE 21:  PROGRAM FILES  (CONT.)

FILE DESCRIPTION
SUPPLEMENTAL 
FILE
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DAO2535.TLB DAO version 2.5/3.5 Backward 
Compatible Type Library

MSJET35.DLL Microsoft Jet engine (version 3.5)

MSJINT35.DLL Localized Microsoft Jet (and DAO) error 
strings

MSJTER35.DLL Microsoft Jet (and DAO) error message 
DLL

MSRD2X35.DLL Microsoft Jet Retro-compatibility access

MSVCRT40.DLL C Runtime DLL

VBAR332.DLL VBA Runtime

VBAJET32.DLL VBA-Microsoft Jet Expression service

UNWISE.EXE Uninstall Utility

TABLE 21:  PROGRAM FILES  (CONT.)

FILE DESCRIPTION
SUPPLEMENTAL 
FILE
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Index
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Offline Group Mode 19
processing modes 5
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auth only transaction 12

B
book transaction 14

C
cancel return transaction 11
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driver’s license guarantee 17
generating reports 46–48
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codes, address verification result 77
context-sensitive Help 3
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creating reports. See generating reports

credit card transaction types
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book 14
cancel return 11
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credit void 11
force 12–13
mail order format 13–15
post-authorization 12–13
pre-authorization 12
refund 10–11
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credit void transaction 11
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data, importing transaction 35–37
debit card transactions

generating reports 45–46
types 15



Index
86
deleting
installment 25
transactions in Offline Group Mode 21

document
audience 1
purpose 1
style conventions 1

driver’ license verification 17

E
e-commerce security 53
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editing

installment 25
transactions in Offline Group Mode 21

enabling Offline Group Mode 19
end of day process, about 6
exporting transactions

about 39
data, exporting 39–40

F
field descriptions 74–76
File menu 63
files, program 82–84
finding

credit card transactions 7–8
transactions in Offline Group Mode 20

force transaction 12–13
format for importing transactions 30–33
formats, transaction record 71–73
Function menu 66

G
generating reports

check guarantee 46–48
credit card 43–44
debit card 45–46
offline group 50

generating reports (cont.)
offline group duplicate 50
offline group result 50
settlement 48–49
settlement error 48–49

getting help 3
GUI Help 3

H
help

context-sensitive 3
getting 3
GUI 3
setup 3
web-based 3

Help menu 70

I
importing transactions

about 29–35
data 35–37
fields 30–33
format 30–33
Import Transactions dialog 33–35
transaction record components 31

initialization strings, about 55
installment billing

about 23
accessing 23
adding 23–25
deleting 25
editing 25
submitting 26–27

Introduction 1–3
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M
menus

Edit 64
File 63
Function 66
Help 70
Report 67
Utilities 68
View 65

messages, program 79–82
MICR verification 18
modem initialization strings 55

O
offline group duplicate report, generating 50
Offline Group Mode

about 6, 19
deleting transactions 21
editing transactions 21
enabling 19
starting 19
transactions, finding 20
using 20

offline group report, generating 50
offline group result report, generating 50

P
password protection, understanding 6–7
PINpad, setting up 16
post-authorization transaction 12–13
pre-authorization transaction 12
prerequisites 2
processing

check guarantee transactions 17–18
credit card transactions 7–8
debit card transactions 15–16

processing modes
about 5
Offline Group 6
Real Time 5
settlement 6

processor response details, about 41
program

files 82–84
messages 79–82

protection, password 6–7
purpose of document 1

R
Real Time Mode, about 5
record formats, transaction 71–73
refund transaction 10–11
refund void transaction 11
Report menu 67
reports, generating. See generating reports
requirements, system 2
result codes, address verification 77
return transaction 10–11

S
sale transaction 9
security, e-commerce 53
setting up a PINpad 16
settlement

error report, generating 48–49
report, generating 48–49

settlement, about 6
setup Help 3
ship transaction 14–15
strings, initialization 55
style conventions in document 1
submitting an installment 26–27
support, technical 3
system requirements 2
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technical support 3
transaction record formats 71–73
transaction types

check guarantee 17–18
credit card 9–15
debit card 15

transactions
check guarantee, processing 17–18
credit card, processing 7–8
debit card, processing 15–16
deleting in Offline Group Mode 21
editing in Offline Group Mode 21
finding in Offline Group Mode 20

transmitting an installment 26–27

U
understanding. See about
using Offline Group Mode 20
Utilities menu 68

V
verification

driver’s license 17
MICR 18

View menu 65
void transaction 10

W
web-based Help 3
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